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1. INTRODUCTION

Thank you for choosing CHC LT600 Series GNSS Hand-held Receiver.

This Getting Started Guide will provide useful information about your receiver. It will also guide you
through your first step of using LT600 Series in the field.

1.1. TECHNICAL ASSISTANCE

If you have a problem and cannot find the information you need in the product documentation,
contact your local dealer from which you purchased the LT600 Series. Alternatively, please request
technical support using the CHC Website (www.chcnhav.com) or CHC technical support email

(support@chcnav.com).

1.2. YOUR COMMENTS

Your feedback about this Getting Started Guide will help us to improve it in future revision. Please
e-mail your comments to support@chcnav.com.

1.3. SAFETY INFORMATION

This manual describes CHC LT600 Series GNSS Data Collecting Terminal. Before using the LT600 Series,
please make sure that you have read and understood this Getting Started Guide, as well as the safety
requirements.

1.4. Use AND CARE
The LT600 Series is designed to withstand the rough environment that typically occurs in the field.

However, the LT600 Series is high-precision electronic equipment and should be treated with
reasonable care.
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2. OVERVIEW

2.1. FEATURES

LT600 is a high accuracy GNSS data collecting terminal independently developed by CHC,
which adopts industrial third level design, IP65 protection level. Positioning accuracy of the
LT600 could reach decimeter, with alternative configuration of 1D/2D bar code scanning,
RFTD, Infrared, NFC and so on. Equipped with high sensitive point touch pen, LT600 makes it
more convenient to collect data and map ground. 4G cellular modem with
Dual-SIM-Dual-Standby offers more choices of experiencing high speed data transmitting.
With 8 inch screen and 16:9 scale, LT600 provides you more open vision and more
convenience.

2.2.  SPECIFICATIONS

LT600
Operating System Android 5.1
CPU Quad-core 1GHz
RAM 2GB
Flash Memory 32GB

Memory Extend

Micro SD, up to 128G

GNSS

Support GPS+GLONASS or GPS+BDS

Accuracy Stand alone:2-5m; SBAS: 2m
Channel 72

Cold Start 30s

Warm Start 1s

WIFI 802.11 b/g/n

Cellular Modem TDLTE, TDSCDMA, EDGE, GSM, WCDMA
Bluetooth V4.1

UsB Micro USB, OTG( support hot plug)
Bar Code 1D/2D bar code scanner(optional)
Li-ion Battery 9000mAh

Voltage 3.8V

Battery Life >12h(continuous work)

Charging Time <4h

Front Camera 2.0 megapixel

Back Camera 8.0 megapixel

Flash Light Support
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Physical specifications

Display

Size: 8inch Corning Gorilla Glass touch screen
Resolution: 1280*800

Brightness: 450cd/m?

Touch screen: Capacitance touch, 5 points touch screen
Point touch pen: Mapping pen with high accuracy

Physical

Dust proof and waterproof: IP65

Shock: Survives 1.5 meter drop onto concrete
Humidity: 5%RH - 95%RH (without condensation)
Dimension: 235mm*138mm* 30mm (L*W*H)
Weight: 660g (with battery)

Operating temperature:-20 °C to + 60 °C

Storage temperature: -30 °Cto + 70 °C

Physical Properties

Bar code: 1D/2D scanning mode (optional)
NFC: Optional

G-sensor: Support

Light sensor: Support

Distance sensor: Support

E-compass: Support

Gyroscope: Support
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3. LT600 OVERVIEW

3.1. FRONT VIEW

— Front Camera

SATELUITE LIST

& ces

GLN

S # eos

R
. ;A
Gy

GLONASS COMPASS GALILEOD

Power Button— —F1 Function Key

Menu Home Return

SIM Headphone Jack

TF SIM Charging/Data Interface

e Power Button

- Turn ON: Press the button for 1-2 seconds, the Power Indicator will turn on and the boot
screen will appear, and then the LT600 will enter the operation system after 30 seconds.

- Turn OFF: Press the button for 1-2 seconds, the SELECT dialogue box will pop up, select
Power off to turn off the device.

- Restart: Press the button for 1-2 seconds, the SELECT dialogue box will pop up, select
Restart to restart the device.
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e Menu Button

Click this button to bring out the start menu.
e Home Button

Use the home button to return main menu.
e Return Button

Press this button to go back to previous menu.
e SIM

Insert SIM card into this card slot.

e TF

Insert TF card into this card slot.

e Charging/Data Interface

This interface is used for battery charging and data transmission between LT600 and PC
through USB cable.

e Headset Jack

Insert your headset into this socket.
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3.2. BAcCK VIEW

Flash Light ke
asi Ignt__| [ ( Optional
Back Camera (Op )
Extension Slot— : —Nameplate
nE
5|3
©
—Strap

Speaker Speaker
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3.3.

SIDE VIEW

Strap

GNSS Module

1D/2D Barcode
( Optional )

Infrared
( Optional )
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4. BASIC OPERATION

4.1.

POWER ON

Before powering on LT600, please make sure the battery has plenty of power. Then
long press the power button for 1-2 seconds to turn on LT600 and enter its home
screen (Figure 1).

Figure 1 Figure 2

Click to make a phone call.

Click E to access contacts information.
Click to open messaging.

Click E to open browser.

Click to open the drawer to see all the apps that have been installed (Figure 2).
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MapCloud

Figure 3 Figure 4

Use virtual button key to facilitate your operation with LT600.

Click E to go back to previous menu.

Click E to return home screen.

Click E to see all the running apps (Fig. 3) and then you can remove apps by sliding

them towards left or right side (Fig. 4).

4.2. INSERT SIM CARD

Please power off the LT600 first and refer 3.3 dFront View to insert the cards into slots
correctly. Then power on LT600 (refer to 4.2 Power on), Click OK in the pop up dialogue
to turn on the SIM card.
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4.3.

Update preferred SIM card?

CMCC is the only SIM in your device, Do you want 1o use
this SIM for mobile data, calls and SMS messages?

"

AGAG.d4 4 11:08

SIM cards Q
SIM slot 1

a CU - +8615593431156 &
SIM slot 2

cMmce ®

Preferred SIM for
Cellular data

cu

Calls
cu

SMS messages
cu

Two SIM cards can be inserted into LT600 together, but they can’t be used at the same
time. Users have to switch between two cards while using Mobile data, Calls or SMS

messages.

AGAG.d & 11:08

SIM cards

n SIM slot 1
CU- +8615593431156

SIM slot 2
cMcc

Q

Preferred SIM for

Cellular data
cu

Calls
cu

SMS messages
cu

LANGUAGE & INPUT

2 Wi-Fi networks available

Select a SIM for data
a Ccu

+8615593431156

cMce

Click Settings/Language & input/Language to select language.
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T I

Language & input Language

Language Bahasa Indonesia
English (United States)

Spell checker Bahasa Melayu
Android Spell Checker (ADSF)
Catala
Personal dictionary
Keyboard & input methods Cedting
Current Keyboard
I60TTARE pansk
Android Keyboard (ADSP)
English (US) Deutsch (Deutschland)

FE0FTHE Deutseh (Ostereich)

Google Pinyin Input

Chiness Pinyin Eesti

Google voice typing English (United Kingdom)
Automatic

Speech English (United States)
Valce Input

Espafiol (Esparia)
Text-to-speech output

<]

@]
[m]

<]

o]
[m]

4.4. DATE & TIME

Click Settings/Date & time and enter Date & time interface.
A )

<« Date & time

Automatic date & time
Use network-provided time

Automatic time zone @
Use netwerk-provided time zone

Set date
April 13,2017

Set time
1034 AM

Select time zone
GRMT+08:00 China Standard Time

Use 24-hour format
100 P

@]

m}

If you want to use date and time from network or GPS, click Automatic date & time to
select Use network-provided time or Use GPS-provided time:

Automatic date & time
(®) Use network-provided time
() Use GPS-provided time

O off

CANCEL
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If you want to set date and time by yourself, please turn off the Automatic date & time
first and then click Set date and Set time to start your own settings. You can also
customize your time zone and choose whether to use 24-hour format in this interface.

Select time zone
GMT+08:00 China Standard Time

Use 24-hour format
1:00 PM

4.5. DispPLAY

Click Settings/Display to enter Display interface.

- Dizplay

Il Wi ™
Errades P bl el e d

‘MalpaceT
[T

Coapies

Brighoraas bl

Adaptsve bnghinesa
ik Ll el P e i b

Ak 14 mererien of iy

DFptna.
=5

Forsd dlie
]

el el o ITAETRD
Bempie iha pomdermg of bha poreen

(= )

< o o
=

Brightness adjusting: Click Brightness level to adjust it according to your preference.

13/35



Sleep

() 15 seconds
() 30 seconds
1 minute
(O 2 minutes
() 5 minutes
(®) 10 minutes
() 30 minutes

) Never

CANCEL

Sleep: Click to optimize the inactivity time.

Font size
O small
(®) Mormal
O Large

() Extra large

CAMNCEL

Font size: Click to change the font size.

4.6. PORTRAIT & LANDSCAPE

Click Settings/Accessibility/Auto-rotate screen to switch between Portrait and
Landscape mode.

L # 46 @ 1926

Settings Q

Wireloss & networks.

¥ WiFi

3 Bluetoath

i sMmcards

(O  Datausage

Wireless & networks

Mare

* Wi % Bluetooth
Device. @ SMcards (O Datausage
i Display l - More (o]
& Sound & notification Davice
4 Display & Sound & notification
= Storage

=  Storage Scanner <

Scanner
~] Battery

Apps

L :3
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4.7. WIFI

Click Settings/WIFI to switch on WIFI. Select WIFI and type in its password to connect.

HW-WIFi2
Connected

W CcHonav

W, GNSS-1014260
v Chimalnicom
h ] huace

. GNS5-116254

w.  WiF#EXT-C4 GNSS-1014269
Security

w.  ZMI_2902 WPA/WPAZ PSK
Password

. GHSS-1111111

w. Hellvou
[[] show password

w. TNT _
[C] Advanced options

L hhh

. CANCEL
<]

O
o

4.8. BLUETOOTH

Click Settings/Bluetooth to turn on the Bluetooth. Find nearby devices and pair with it.

]

Bluetooth

On

Paired devices
3 GNSS-1002521 =]
Available devices

% GNSS-1014260
L QH-201510268%GH
' xiaomi-bt

AMDROID BT is visible to nearby devices whils Bluetoath settings is open,

Paired devices
Nisme

GN5S5-1002521

FORGET =13
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4.9. USB CONNECTION

For connection or data transmission between LT600 and the office computer, please use the
USB data cable. Select connection type as Media device (MTP) in notification center as
shown below.

)

USB computer connection

Connected as a media device

% Cannectas
Touch for other LISH options,
USB storage
USE debugging connected XP recommended. Allows transfer of filos betwoen the camputer and an ()
Touch to disable USE debuggeng. Android device.

Media device (MTF)

Lets you transfer media files on Windows or using Android File Transfor @®
on Mac (see www.androld com/filetransfer

Camera (PTF)
Lets you transfer photes using camera software and transfer any files on C‘
computers that don't support MTP

Charge only
Stop all USB functions. Speeds up USE charging and decreases power %)
consumption.

Caonnect as CO-ROM

Built-in CD-ROM @)
Show a virtual CO-ROM containing some useful software,

Before connection, please click Settings/Developer options/USB debugging to make
sure this function is switched on. After USB data cable is connected with PC, wait until the
Allow USB debugging dialogue pops up, click OK.

You can also use Android mobile phone assistant to manage the documents and data
stored in LT600 and install software like MapCloud3.0, GNSSTool.

4.10. Use CAMERA

Click Camera icon to openiit.
fial
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n Click to start recording the video, click again to finish.

=
Click to take a photo.

Slide fingers in the left column to switch between 5 different modes:

E Normal mode
PIP mode
Live photo mode

E Panarama mode

ﬂ Multi angle view mode

E Camera Settings

Click to configure related parameters

4.11. LOGIN 4G

After inserting your SIM card, click Settings/More/Mobile Networks/Preferred network
type and select corresponding network type of your SIM card. Then Click SIM card icon
in the pull down menu and turn on Mobile data and click More Settings to see data
usage.
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¥ 4G% @ 19:46

253KB

Preferred network type WEH
(@) 4G (recommended) . 73,5408
36
Total G
O26
O m

4.12. SCHEDULED POWER ON & OFF

LT600 allows users to achieve scheduled power on and off by setting the power up & off
time and repeat time.

5 9 S 4 14:50 IR ] + % 0 @500
Schedule power on & off Set schedule power on REVEAT DONE
= 07:00 TIm
gty 0700
. Repeat
s ; Every day
<] 0] (m] < O ]

Set Scheduled power on time and click OK.
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2 13
1 i 1
a2 14
10 2
21 9 3 s
it 4 4 16
7
& 5
19 17
L5

Set scheduled power on repeat time and click OK.

Repeat
Monday
Tuesday
Wednesday
Thursday
Friday
Saturday

Sunday

CANCEL 0K

Scheduled power off time settings is the same with Scheduled power on.

4.13. LOCATION

Click Settings/Location to switch on location service.

I W @4k

« Location Q
On B

WMode

Device anly

Recent location requests

Dialer
Law battery use

Location senvices

s Google Location History
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5. GETTING STARTED WITH MAP CLouD 3.0

Map Cloud 3.0 is a type of mobile GIS data collecting software developed independently by
CHC. Combining map display, GPS data collecting, edit, attribute input, this software
provides a perfect GIS solution for users. Let’s get started from the registration part.

5.1. REGISTER

1. Click Settings > Register in the upper right corner to find your Device ID and send it to
support@chcnav.com. We will provide the License you need for registration.

Project

Layer
‘.Egl ye
Import
Expor
| 1
ey &

v 8e

< Settings

Collection Settings >
Coordinate System >
Map Window >
Software Register
Track Management >
Shanghai Huace Navigation Technology Co,Ltd.

\ MapCloud

Baidu Map Settings / 3.1.9466
Unregistered
Check Update Current Ver:3.1.9466 ihalin:
REGISTER
Register Unregistered 3 |
< o
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2. After applying license successfully, users can check registration information like expire
date as shown below.

Y e e

€ Settings
Collection Settings >
Coordinate System >
Track Management >
Baidu Map Settings z

> Software Register
System Settings > hai Huace
MapCloud
Check Update Current Ver:3.0.7865 3.1.9466
Rogistered Expiry Dato: 2017.07-23

Register Expiry Date: 2017-0510 ) REGISTER AGAIN

5.2.  INSTALL & UPDATE GNSSToOL

Click GNSSTool icon in the upper right corner to install or update the GNSSTool software.

© Tips

GNSS server not found.install it or not?
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e LA BRI
i, GNSS Tool

Do you want to install this application? It will get access to
PRIVACY

Y. read phone status and identity

@ approximate location (network-based)
ation (GPS and network-based)

precise |
s Tead your contacts
'}l madify or delete the contents of your SD card
read the contents of your SD card

DEVICE ACCESS

T, change network connectivity

nnect from Wi-Fi

view Wi-Fi connections

3 access Bluetooth settings
pair with Bluetooth devices

E] close other opps
run at startup

u draw over other apps

CANCEL NEXT

5.3. BuiLD NEwW PROJECT

1. Open MapCloud3.0 and click "+" to build new project > choose "Project Template" and
"Coordinate System" >click " v " to finish;

e ¥ 2 §o3e

< Project Management -!—"f'-\' & oo = New Project

Project Name Pro-2017-04-11-10-37-21
Path fstorage/emulated/0/ >
Template QuickProjectCh
Coord Sys Beijing1954_GaussKruger »

Description

Default project

2. Click satellite icon in the upper right corner >click "Connect" >choose "Connect Method,
Device Type" >Local Connection Successful >Return.
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v a e ER T

& GNSS Tool T cvecx upoars wroruanion '@ rrciTen
B Unknown B8 Huriiser. 00

LI Unknown Statun: Unknown

MM Unkcngwn HRMS{m]. Lnknown

Diff Data: 08 VRMS{m]) Unknown

it Delay(s) Unknown

Connect LocalUnconnected

Sky Plot

- Debugging Data

[
I..J
2047 m
<
v e PR w o U
& Connect 3 D) cnecx e mromasmion O mecien
B 310%:58.B192N SV's Mumber: B/19
Device Type Local =
LI 128719000648 Statuz: Single
Device ID LT600 ~ H{m):  38.300 HAMS(m}: 4469
O Data: 0B VRMS(mE & 00
DT Delarn): 0.000
Connect LocalConnect Successiully
Sky Flot

Debugging Data

DISCONNECT CONNECT

g O [m]

5.4. COORDINATE SYSTEM SETTINGS

1. Click Menu >"Settings" >"Coordinate System" >"Projection Parameters" >Set “Central
Meridian” and “East Shifting” >click " v " to save;
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Project

' v @ e

€ Settings

Layer

Import

Export

[ -]

8047 m

vae

€ CRS Preferences

Project Name pro-2017-04-11-10-37-21

Target Ellipsoid Beijing 1954 »

Collection Settings

S

Coordinate System

"’

Projection Parameters Gauss-Kruger

it eeliora meter:]

[Sevenlearameaters]

Sitelealibation]

Track Management

Baldu Map Settings

System Settings

Check Update

Register

X

< Projection

Current Ver:3.0.7865

Expiry Date: 2017-05-10

0

Projection Type Gauss-Kruger ~
|Cem Merid 120Deg 00Min 0 rJnSecl
Orig Lati 0Deg 00Min 0.00Sec
|Eas! Shifting(m) 500000.0'
North Shifting{my) 0.0
Scale factor 1.0
Azimuth 0.0
Parallel 1 0ODeg 00Min 0.00Sec
Parallel 2 ODeg 0OMin 0.00Sec
Long 15t ODeg 00Min 0.00Sec
Long 2nd 0Deg 00Min 0.00Sec

v o (m] =]

2. Type in 3 or 7 parameters, or open “Site Calibration” >click
point >click “Calculate” > click " v " to save and then starts collecting.

to add known
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X ; XK

€ Site Calibration —- 400 Pt C. & Add Points

Point Name

ong/Lat GET CURRENT POSITION

N:

E:

H:

Platform Coordinate

NI

E:

5.5. IMPORT BASE MAP

1. Click menu button of hand-held receiver >”Import” >”Import Vector Data” or “Import
Map” > choose the file to be imported.

v B ¥

Project < Import
i
Layer W Import Vector Data
['__J (*.shp..cf)
| Import o Import Raster Data
L i s i)
Export
Setlings
'
.-.«
-y
B0 47
< o o < o a

5.6. DATA COLLECTION
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1. Click the button in the lower right corner >”Point” >”GPS” >click save to finish collecting
(the same for line or area collecting)

v o
£ Attributes

& ¥ |e Layer Point =
Coordinate \
name Py

descriplions

5.7. EXPORT DATA

1. Click menu button of the hand-held receiver >"Export" >click “Export Vector
Data” >choose the point/line/area layer and its format you want to export >click " v " to
export.
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s B .

Project

4 Export
Layer A Expost Veclor Data
L' s Bl o)

Import

Settings

(7.

<

Pl B

€ Folder Select

/storage/emulated/0
ESRI Shapefile * -

@' Busic
@ Polygon O

"o Line

@ rFoint

| Fodcasts

| Ringtones
Alarms

Hotifications

]

B Pictures

Movies

I

= Download
S| ooiM
F) Android
[ mtkiog
@' L57Leg
B cricmav
F‘j Suparhiap

ALL INVERT CANCEL

4 o) o q

0]
a
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6. GETTING STARTED WITH GNSSTooL

GNSSTool is a kind of service mainly used for access to data and Local, Bluetooth and WIFI
connection. External App can send command to receiver by using GNSSTool through
broadcasts. Thus users only need to connect with GNSSTool to achieve communication with
the receiver. It will be running in the background once connected and there is no need to
start it again.

6.1. REGISTER

1. Before using GNSSTool, users need to register first. Please find your Device SN in register
interface and send it to support@chcnav.com, CHC will provide Register Code for you.

Unregistered GNSSTool only allow for 30 minutes tryout.

] ER ]

GNSS Tool ¥T) cHecx uPDATE NFoRMaTion 'O

B:  Unknewn SV's Mumber: 0/0

L:  Unknown Status:  Unknown

Himb:  Unknown HRMS(m): Unknown

Diff Data: OB WRMS(m]: Unknown

Diff Delay(s): Unknown Software Register

CHC Technolagy Co., Ltd
Connect LecalUnconnected Copyright @ 2015 HuaCe Inc
All Rights Reservad.

Sky Plot b GMSS Tool

1.1.9465

Unregistered

Debugging Data

B | Device sMAUTFLX32222

Register Code:

REGISTER

2. After registration, users can see the software version and expire date in register
interface.

Software Register

CHC Technology Co. Ltd
Copyright (@ 2015 HuaCe Ine
All Rights Reserved.
GNSS Toaol
1.1.9465
Registered
Trial period:2017-07-23

REGISTER AGAIN
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6.2. CONNECTION

1. Open GNSSTool, click Connect and select Device Type and Connection Type/Device ID
in connect interface.

[
C

onneéct

GNSS Tool

Device Type Local -

M) Wlkngsm HRSAS(r  Unikrgwm Derice ID L7600y =

Y Dt Dl WS Uinkrecmn,

DalF g} Whikcrwn

Connect LecalUnconnected
Sky Plot
Debrigging Data

(8] O

2. Device Type: GNSSTool currently supports 4 types of device: Smart RTK, GNSS RTK,
Local and Peripheral. Local supports typical mobile phone and CHC customized hand-held
controller like LT40 and LT600. Peripheral supports NMEA0183, X360 Series and other
devices. Here for LT600, we choose Local.
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3. Connection Type: For smart RTK (like i80), we select Bluetooth, WIFI or Demonstration.
For GNSS RTK (like X91), we select Bluetooth, and Demonstration. For Local and Peripheral,
we select the specific device type that we use. Here we select LT600 for Connection Type.

Connection Type

4. Click Connect to connect with the receiver, then go back to the previous interface.
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LE R B RRE ]

¥) coex ormars setmuren O menrin
B YR 4 $950H B b 12008
[N R EATT " TF S gl
My 45900 VRS 1438
Gl Gt Ol VEME m): 4 000

Calf aaplal 0G0

Miessage Connect LocalConnect Successiully
Connect Successiully

Diff Data Source CORSLogout
T

Sky Plat
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6.3. CORS LoGIN

After connection successful, we can log in CORS to receive differential data. Users can log in
CORS in 4 different ways: CORS, APIS, TCP and RTCM SDK. Before log in CORS, please make
sure the device has been connected and the hand-held is connected to the Internet.
GNSSTool will automatically disconnect CORS if the device is disconnected.

1. Click Diff Data Source in the main interface, select Diff Data Source as CORS.
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2. Typein IP, Port, Source Table and other parameters and then click LOGIN.

€ Diff Data Source

|I)l" Data Source CORS | DEf Data S CORE
Ly [
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s (T
Passwond Paigwond
Cormection Data 0l Canvecicn Duin 0B
LOGIN BACK LOGN BACK

6.4. SKky PLot

1. Click Sky Plot and see how many satellites (including GPS, GLONASS, BDS, GALILEO and
SBAS) the device is currently tracking and data of satellites list.
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6.5. DEBUGGING DATA

1. Click Debugging Data to see NMEA0183 standard data in data debugging interface. Click
HEX to change the data display format from hex into txt, or pause, save and clear it by using
the upper side buttons. Users can also check Hex in the lower left corner to send commands
to OEM board for debugging.

390 0ass 5 f @
GNSS Tool CHECK UPDATE INFORMATION @ RecisTiR & Debugging Data
B:  Unknomn SVs Number. 0/0 s i e T
L Unknown Statue: Unknown SO0, 0865922420 677 305256 T OB RAOTS
$GLGEY2,208,76,35,327,50,84,08,026,85,47,066 40,85 42,1 52.37,0°73
Him):  Unknewn HRMS{m): Unknown SGNGLL..054903 DOMHNEF
SGNGST54903,00,0.0000,. 1038467131 7449
Diff Data: 08 VRMS(m): Unknown SGNGMM“"“? -0.00.33.99,...773

6630416666667 Jongitude:121,78861033333334,2hitu
= GBI0416666667 longiude:]21. 26861033333334 &ttty
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Debugging Data > GPGSV,1,11,03,07,247,27,04,31,08,,32,09, 300452
GPGSY,Z11,14,29,16,64,332,37,.21,.28,23, 350457
,3,11,26,52,029,40,27.55,167,37,31,.36,0761
GLGSV2,1,08,65,19,224,28.66,27 286,27 67,05,332.75,45,038,40,0472
3GLGEY2,2/04,76,35327,31,84,08,026,85,47,065,41,86,42,152.37,0°70
GHGLL,.. 05490400 N*58
SGNGST,054904.00,0.0000,.. waa -16? 1317*4E
.0,00,99.

Diff Delay(s): Unknown

Grssinfo-latitude 311663041 6666667, ‘Qllgllllde 121, ‘ZMS'IOGGGSSS:M aliiiuce: -i
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SEND
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CHC - Shanghai HuaCe Navigation Technology Ltd.

Building C, NO. 599 Gaojing Road,
Qingpu District, 201702 Shanghai, China
Tel: +86 21 542 60 273

Fax: +86 21 649 50 963

Email: sales@chcnav.com | support@chcnav.com

Website: www.chcnav.com
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